Complete guide to Lightroom
ADOBE’S POWERFUL RAW EDITING SOFTWARE

YOUR COMPLETE GUIDE TO CREATING BETTER PICTURES WITH ADOBE’S RAW EDITING SOFTWARE

FULL STEP-BY-STEP GUIDES
// IMPORT AND ORGANISE RAWS P2
// MASTER THE DEVELOP MODULE P8
// UNDERSTAND THE TOOLS P12
// ENHANCE COLOUR & CONTRAST P16
// EDIT FASTER WITH THESE TIPS P20
// CREATE A MONO MASTERPIECE P24
// USE THE OTHER MODULES P28
// ACHIEVE PRINTING PERFECTION P34
// EXPORT EDITED RAW FILES P38
Welcome to our complete Lightroom guide, where we'll show you how to use Adobe's RAW editing software from start to finish. Back in the days of film, you'd spend time in a darkroom perfecting the developing process. Now, using digital cameras, we still need to ‘develop’ our shots, but this is done with software back at a computer. Lightroom allows you to work up digital images, and is particularly useful for RAW files because they hold extra information for you to utilise. There are currently two versions of Lightroom available – Lightroom CC and Lightroom Classic CC. We’ll be using Lightroom Classic CC, and we go into more detail about why here. So whether you're new to the program, or you’ve been using it for years, jump on board and follow the video lesson (bit.ly/lrvid1) to learn some new tricks.

What do JPEG and RAW mean?

JPEG has become a household name for its ability to compress file sizes without losing too much quality and is universally compatible. It stands for Joint Photographic Experts Group, the group that developed the image file format. Conversely, RAW is not an acronym nor a filename extension – most camera manufacturers have their own bespoke formats, such as Nikon’s NEF and Canon’s CR2 RAW extensions (though DNG is a universally compatible RAW format). It literally means the ‘raw’ data straight out of the camera, as it’s unprocessed and larger in file size. This makes RAWs much more versatile when editing in a program like Lightroom Classic CC, as the additional data allows you to change the exposure, fix white balance issues and make other edits that are tricky or impossible with compressed JPEG images.

Lightroom Classic CC

The fully-featured desktop program

This program comes with the Adobe Photography Plan (currently £9.98 per month), where you’ll also get Photoshop CC, Lightroom CC (above) and 20GB of cloud storage. This is the program formerly known as Lightroom CC and is the successor to the older standalone Lightroom 6 program. Although you get cloud storage included with this plan, it’s quite a small amount and you don’t have to use it. For the most part you’ll be saving your shots on your computer’s hard drive or external drives, especially if you have terabytes of images. Our Lightroom series will be based around Lightroom Classic CC for the most part as it’s the fully-featured, flagship program that photographers have grown to love using. The first step is importing and sorting your pictures, so that’s exactly what we’ll be covering over the next four pages.

Lightroom CC

The cloud-based portable editing option

The brand-new Lightroom CC package is a cloud-based editing program available for computers, mobile phones and tablets. Think of this program as Lightroom Creative Cloud so as to not confuse it with Lightroom Classic CC (below). This is because it relies more on remote storage, with an option to sync your pictures to the cloud so you can work on them anywhere. Currently, it’s part of the Adobe Photography Plan (£9.98 per month) where you’ll get 20GB of storage. There’s also a 1TB Lightroom CC option for £9.98, or a 1TB Photography Plan for £19.97 per month, which will also give you the Lightroom Classic CC and Photoshop CC programs. At this moment it lacks key features found in Lightroom Classic CC, so its strength comes from its flexibility when editing away from your computer or hard drive.

Dan Mold explains how to import images into the Lightroom interface and maximise the potential contained in RAW files.

WHAT YOU NEED

- Lightroom Classic CC
- A batch of images you’d like to bring into Lightroom for processing

PROCESSED RAW

Above We’ve been able to work up the RAW image exactly how we want to because they have much more exposure data.

RAW

Above Unprocessed RAW images look flat, but this is because they aren’t processed in-camera, so you can apply your own edits in software.

JPEG

Left JPEGs are smaller files and look better straight from the camera due to in-built editing.

IMPORT AND EDIT

Lightroom takes time to import your images, which then speeds up the editing process as your edits can be applied instantly.

EDIT ON THE GO

Lightroom CC is available as an app for desktop PCs, mobile phones and tablets so you can edit your shots wherever you are.

MODULAR INTERFACE

The Lightroom Classic CC interface is broken up into seven modules, including Library and Develop.
Understand the Import interface

Importing is the first step you’ll take in Lightroom, as you’ll need to find the images on your hard drive or memory card to bring them into the Lightroom interface. This interface does a whole lot more than just locate your pictures though – you can save time by renaming the files here, adding copyright information or applying a creative preset to your images as they’re being imported. Here’s an in-depth look at the interface so you can start taking full advantage of this feature.

Source Panel
This is where you’ll start the import, as this panel lets you specify the folder of images that you want to import into Lightroom Classic CC. Any hard drives and storage media devices will be shown here – just click through them to find the images you’re after. Tick the Include Subfolders option if you want to import images located within deeper folders, or untick it if you just want to bring in the photos from a single folder location.

Thumbnails
The images in your sourced folder (and subfolders if chosen) will be shown here. A tick next to them means they’ll be imported. Video files will have a video icon on the thumbnail.

View is great for viewing your images one at a time.

Copy as DNG, Copy, Move, Add
Here you have the option to choose whether your RAW files are copied, moved or added. If you’re importing from a memory card you’ll want to use Copy, as this will copy the files from the card onto a location on your computer’s hard drive. The Copy as DNG option will convert your RAWs to universally compatible and smaller DNG files. When importing from a location already on your hard drive it’s best to click Add as this will stop duplicates being made and taking up space. The Move option lets you move the RAWs to a new preferred location and add them to a catalog.

Choose Which Images You View
These options allow you to filter between all of the photos in your source folder (All Photos) or just the new ones that are yet to be imported (New Photos). The Destination Folders option allows you to see what images are currently in your destination folder.

File Handling
Your image previews are set to minimal by default for faster import times, but can be changed here. The Build Smart Previews option increases import times, but it allows you to keep working on RAWs if your hard drive is disconnected. There’s also the option to ignore duplicate images so you don’t take up more space and the Make a Second Copy To option is handy for creating a backup on a separate hard drive. Add to Collection lets you assign your image to a collection of your choice such as black & white.

File Renaming
This allows you to change the names of your files, adding the date, sequence number and custom title of your choice such as Wedding 01 and so on.

Apply During Import
This panel makes it possible to apply a basic edit to your images as they’re being imported. This will extend your import times but overall can save you work when you start editing your images. For example if you know you want your images to be black & white, or you want to apply your own custom settings to a batch of landscapes, you can apply it as the images are being imported. You can also add Metadata such as copyright information, and Keywords which makes them easier to find.

Choose Your Destination Folder
Depending on which option you choose at the top of the interface (Copy as DNG, Copy, Move or Add), your images are going to be copied, moved or added to a location on your hard drive. This panel lets you change which folder the imported images will be stored in – they’re organised by date by default. Into Subfolder will import your images into a new, separate folder for each import, keeping them segregated and making it easier to find your pictures.

Import or Cancel
Cancel will abort any changes you’ve made, while Import will take you to the Develop module and start bringing your images into the interface. You’ll see a progress bar in the top left corner, indicating how long it will take to process your images and load them in.

"File Renaming, Copyright Info and Presets can all be applied within the Import interface"

"tip go solo!" Right-click on the panels and choose Solo Mode. This makes sure only one panel is open at a time, keeping the interface neat, tidy and less daunting.

"grid view and loupe view" Check All will tick all of the images on the screen so they will be imported. Uncheck All will untick them all – handy if you only want to import a small selection of RAWs. Holding the Alt key will turn these buttons to Uncheck Videos and Uncheck Videos – this is really useful if you don’t want to import large videos that are in the same folder as your RAW images.

Sort
This feature makes it easy to sort and view the images by Capture Time, File Name, File Type, Checked State and Media Type.

Thumbnails and Zoom Slider
This lets you change the size of the thumbnails when working in Grid View, or the level of zoom when working in Loupe View.

Genius Import Presets
Got everything in the Import dialogue set up exactly as you want it? You can create a preset using the Import Preset option. Just click on None from the Import Preset bar at the bottom of the interface, and choose Save Current Settings as New Preset to save time on future imports.
## The Library Module

The **Library Module** is where you organise and choose the images that you want to work on. You can add metadata and keywords here, making it easy to search for images and identify groups of pictures with a specific theme. You can also rate and colour code your images, making it easier to shortlist a smaller group of pictures you want to work up and apply some quick edits to. Your in-depth image editing will be done in the Develop module which we’ll cover in the next issue.

### CATALOG

A catalog is a database that tracks the location of your photos and information about them. Changes that you make to your images, such as edits, keywords and metadata are stored here in the catalog. Depending on your preferred working style you could have a single Catalog with all of your images in, or separate Catalogs for each shoot.

### FOLDERS

This will show you the folders your images have been imported to. If you used the Info Subfolder option in the Import dialogue then each Import you’ve made will have its own folder. Clicking on a folder will bring up the imported images and edits within it.

### COLLECTIONS

Collections allow you to group a set of images from separate shoots or import locations. If you want to make a collection of your best landscapes you could select the photos you want to add by holding Ctrl and clicking on the images to select them. Then click on the Plus icon next to Collections and choose Create Collection, then name it and click Create. You can then drag any images from the filmstrip into this collection to add them. Then click on that collection and you’ll only see the photos that you’ve selected.

### IMPORT AND EXPORT

Import will let you find and bring in images from a hard drive or memory card. Export will let you save any images you currently have active in the filmstrip at the bottom. There’s a whole range of export settings and image formats that you can save as including JPEG, PSD and DNG.

### NAVIGATOR

This shows a thumbnail of your image and you can use it to quickly zoom in on a specific area of your shot. Choose Fit to fit the whole image on screen. Fill will make sure the length of the picture fits the entire workspace – this will be even larger if you collapse down the panels with the left and right arrow icons.

### FILMSTRIP

This shows you the images in your current import. Click on the image to select it. You can then hold Shift to select multiple images to make several active at once. You can also hold Shift and click on the first and last image you want to select a series.

### SYNC WITH CC

Clicking this will allow you to sync with the Lightroom CC cloud. Depending on which Adobe Photography plan you’re on you’ll get a certain amount of storage. The Photography Plan 20GB is £9.98 per month, though will get full quickly. That said, it can be handy to upload important files if you plan on comparing two images side-by-side.

### TIP

**USE SMART PREVIEWS**

Smart Previews let you work on a low-res image and when your hard drive is reconnected, the edits will be applied.

### USE FILTERS AND SYNC

Right-click on your image to Set Flag, Set Rating and Set Color Label. These are great ways of marking your pictures, you can then use the Filter drop-down menu to choose which images you want to see. The Sync buttons allow you to Synchronise metadata and develop settings.

### HISTOGRAM

This shows you the tones and colours of the selected image as a graph, with shadows on the left, highlights on the right and midtones in the middle. This makes it easy to see if any parts of the shot have clipped to pure black or white. You’ll also see the exposure information underneath such as the ISO, aperture and shutter speed. Click on the ‘Original Photo’ tab under the histogram to create a Smart Preview (see tip below).

### KEYWORDING AND KEYWORD LIST

The Keywording panel allows you to add keywords to your pictures and this will make them easier to find when searching for them at a later date. The Keyword List panel contains a list of previously used Keywords and you can click the square to the left of the keyword to add it to the selected image, or click on the arrow to the right of the keyword to take you to all of the images that share that keyword.

### QUICK DEVELOP

Most of your editing will be done in the Develop module, though this panel makes it possible to apply some basic tweaks such as adding a preset, changing the White Balance or applying Lightroom’s Auto Tone Control.

### METADATA

Metadata will show you all of the camera’s EXIF data such as the date and time the picture was taken and the settings used. If you haven’t set up copyright information in-camera, you can add it here. Click Preset>Edit>Presets and then fill in the IPTC Copyright section and hit Done, then click Save As, and call it Copyright. You can then easily add this preset to any images you want to add your copyright information to in the future.

### BOOKMARKS

Collections allow you to group a set of images from separate shoots or import locations. If you want to make a collection of your best landscapes you could select the photos you want to add by holding Ctrl and clicking on the images to select them. Then click on the Plus icon next to Collections and choose Create Collection, then name it and click Create. You can then drag any images from the filmstrip into this collection to add them. Then click on that collection and you’ll only see the photos that you’ve selected.

### CHANGE YOUR VIEW

**Grid View** (G) shows all of your images as thumbnails and can be enlarged with the Thumbnails size slider. **Loup View** (F) shows a single image much larger within the same interface. **Compare View** (C) lets you compare two images side-by-side, while **View Survey** (N) allows you to select a batch of images to view at once. **People View** (D) uses Face Detection and can group together images of the same people.

### PAINTER TOOL

This tool makes it easy to copy over information from one image to several others, such as Keywords, Metadata, Ratings and Flags. Click on the image in the filmstrip with the information that you want to copy and then, with the tool active, click on all of the images to which you want to apply that information.

### RIGHT-CLICK ON IMAGE

Right-click on your image to bring up even more options – useful for creating HDRs and Panoramas or Setting Ratings and Flags to mark your pictures. You can also remove your image from Lightroom or choose Create Virtual Copy to create a clone of your RAW image – great if you want to apply multiple different edits to a single picture.

### NEXT STEP PROCESS YOUR RAWS IN DEVELOP

Now you’ve got to grips with importing and organising your images, it’s time to edit! In the next installment we show you how to get the most out of the Develop module, which is where you’ll do the majority of your editing.
Dan Mold runs through Lightroom’s Develop module to show you how to get the most from the plethora of tools within.

In the second part of our guide to Lightroom we’ll be inspecting every panel within the Develop module, explaining what each does, when to use it and how to do so effectively. We’ve labelled the interface below alphabetically to make it easy to see which panel we’re talking about and where you can find it.

The panels in Lightroom Classic CC can be expanded and collapsed by clicking the arrow next to their heading. We’ve also labelled the panels on the right-hand side by clicking the arrow next to their heading. This can appear daunting to first-time users. Even if you’ve been using the program to edit your shots for years, it’s likely there are a handful of useful features hidden away that you’ve glanced over but never touched, so we’ll show you how to incorporate them into your workflow.

Start processing with the Basic panel

The sliders in the Basic panel are extremely versatile so you may not need to touch any other panels if you’re making a quick conversion. You can change an image’s white balance with the Temperature slider to make your picture cooler or warmer and adjust green and purple colour casts with the Tint slider. The Exposure slider lets you change the exposure up to +/-5 EV, though realistically you won’t want to push it past +/-2 to maintain image quality — a feat not possible with compressed JPEGs. Hold the Alt key as you adjust the Exposure, Highlights, Shadows, Whites and Blacks to see if any of your tones are clipping, which means they have burnt out to pure white or black.

Use the Detail panel to sharpen your shots

Under the Sharpening heading you can drag the Amount slider to increase or decrease the degree of sharpening — slightly soft images will benefit from higher values. Increasing the Radius will enlarge the spread of the sharpening around the edges and Detail helps you get the right mix of sharpness to noise. Hold Alt as you adjust the Detail slider for a grey overlay that helps you see the noise as you increase it. Masking is an incredibly useful slider that can be used to restrict the sharpening effect on just the details and not background noise. Hold Alt and drag the Sharpening slider — you’ll see a black & white overlay in which only the white areas are being sharpened. Drag the slider to the right until only your subject is displayed in white.

Use the Detail panel to reduce noise

There are two types of digital noise caused by increasing the sensitivity of your camera’s sensor (ISO value) — luminance which is monochromatic and similar to film grain, and chroma which resembles coloured speckling or film grain, and chroma which resembles coloured speckling or film grain, and chroma which resembles coloured speckling or film grain, and chroma which resembles coloured speckling. Most images will benefit from increasing the Luminance slider a little and the chroma noise is usually handled pretty well by Lightroom’s default values, but you can increase the Color slider if speckling is still visible.

Correct distortion

Head over to the Lens Corrections panel and make sure you’re under the Profile heading. Now tick Enable Profile Corrections, allowing Lightroom to go through its catalog of lens profiles and apply edits to remove lens distortions such as vignetting, pincushioning or barrel distortion. If you zoom in on your image and see any purple or green fringing around edges of high contrast it’s worth turning on Remove Chromatic Aberration to remove this. In this panel you can enter your lens model manually, control the amount of distortion and vignetting as well as click on the Manual heading for even more control.
Organise your shots with Collections

Collections allows you to group a set of images from separate shoots or import locations. If you want to make a collection of your best landscapes you could select the photos you want to add by holding Ctrl and clicking on the files of your choosing. Now click on the Plus icon next to Collections and choose Create Collection, name it and then click Create. You can then drag any images from the filmstrip into this Collection to add them. Clicking on a Collection will show only the photos that have been selected to appear.

Save key points in your edit with Snapshots

Snapshots are a way of recording a specific point in your edit so that you can click on it at any time to revert to those settings. To create one, click the plus icon in the Snapshots panel and then give it a suitable name. This can be handy if you want to experiment with your shot as you can revert back easily.

Go back to a specific edit with History

Similar to Snapshots, the History panel lets you revert back to a previous time in your edit. Every time you make an adjustment within the Develop module it’s stored in the History panel and you can click down the list to go back until you find the point you want. But if you then make more adjustments, your old edits will disappear from the History panel.

Get creative with the Effects panel

There are three main edits you can make in the Effects panel – vignette, grain and dehaze. You can use the Post-Crop Vignette to make the corners of your picture lighter or darker. There’s a great level of control over your vignette here as you can use the sliders to change how round or soft the vignette appears. Dragging the Grain Amount slider to the right will make your shot look gritty, like an old film photo. Size changes how large the specks of grain are, while Roughness adjusts how fine or coarse the grain is. Dehaze is a single slider designed to cut through haze, fog, mist and cloudy shots to bring back detail. Dragging it to the right will bring back detail, but will soften your shot when dragged left.

Tweak contrast with the Tone Curve panel

With the Channel set to RGB, pushing the line on the graph up or down will brighten or darken your shot, respectively. An S-shaped curve (see image above) is good way to really ramp up contrast. Setting the Channel to Red, Green or Blue allows you adjust the contrast of individual colour channels.

Apply a duotone with the Split Toning panel

This panel lets you assign one colour to the highlights and one to the shadows in your image to achieve a classic split-toning effect. You can adjust the Saturation of each colour and also use the Balance slider to fine-tune the bias towards your selected shadow and highlight tones.

Fine-tune colours with Camera Calibration

This allows you to change to older processing versions and will give you the older sliders such as Fill Light instead of Shadows and Recovery instead of Highlights. You can also change the Profile to get a new look or adjust the sliders beneath to fine-tune how much red, green and blue is in your shot, or adjust them for artistic abstract results.

Take control of your colours with HSL

HSL stands for Hue (colour), Saturation (intensity) and Luminance (brightness) and lets you fine-tune individual colours in your shot, such as a blue sky. The B&W option converts your shot to mono where you can use the colour channel sliders once again to darken or lighten specific colours in your shot.

Correct converging lines with Transform

If you have a picture with straight lines that appear to bend, you can fix this with the Transform panel. The Vertical and Horizontal sliders can be used to angle your shot up, down, left or right, though you’ll want to make sure Constrain Crop is ticked so you don’t end up with white corners.

Lightroom’s Toolbox

Here you can activate Lightroom’s six tools – Crop (R), Spot Removal (Q), Red Eye Correction, Graduated Filter (G), Radial Filter (Shift+M) and Adjustment Brush (K). Click on them to reveal the Tool Options below and click back on them when you’re done to make the tool inactive.
Complete guide to Lightroom

Part 3 // Understanding Lightroom’s Tools

Dan Mold runs through Lightroom’s powerful tools so you can edit your RAW files more effectively.

**A**

*The Age-Old Proverb Says,* a man is only as good as his tools. That certainly rings true for the virtual tools found within Lightroom’s picture editing software. There’s a whole host of tools in the Develop panel to help you edit your RAWs, with the main six taking pride of place in the Toolbox – Crop, Spot Removal, Red Eye, Graduated Filter, Radial Filter and Adjustment Brush. But there’s also a trio of tools tucked away in the panels beneath that it would be easy to overlook – White Balance, Targeted Adjustment and Guided Upright, and all have fantastic features.

So in this tutorial we aim to bust the jargon and explain what each and every tool does, where you can find them and when you should use them to enhance your shots. Get stuck in and follow the accompanying video lesson (bit.ly/lrvid3) to see how.

**B**

**Crop Tool**
The Crop Tool allows you to recompose by removing parts of your shot that you don’t want to appear in the final image. Choose the Crop Tool in the Toolbox and then click the Original drop-down box. You can then choose different aspect ratios such as 1:1, 2:3 or 5:7. You can also set your own custom aspect ratio by clicking the lock icon to unlock it. Now draw your crop box over the image. To make sure your aspect ratio is fixed you can click the lock again or hold the Shift key as you pull the corners of the crop box. You can also hover your cursor over an outside corner of the bounding box and, when the double-ended arrows appear, you can drag to rotate it. To go from a portrait crop to landscape, or vice versa, hit X on the keyboard.

**C**

**Straighten Tool**
A straight horizon is an easy way to strengthen the composition of your landscape images, unless you were intentionally framing up on the wonk. A simple way to make sure your shots are absolutely level is to use the Straighten Tool. It’s found within the Crop Tool options and all you need to do is click the tool to make it active and then run it over your horizon to sure it up. It also comes with an Auto button that you can press to let Lightroom have a go, or you can use the Angle slider to change the rotation of your crop until you can see it is level by eye. Then drag the corners of the crop bounding box as per usual to crop your shot without changing the angle of the horizon.

**D**

**Guided Upright Tool**
The Transform panel contains the Guided Upright Tool which allows you to draw over converging lines in your shot that you want to straighten – brilliant for tall buildings or other vertical structures in landscapes. The panel also contains automatic modes – Auto, Level, Vertical and Full – in addition to sliders such as Vertical and Horizontal which allow you to get a finer level of control. This panel shares much of the functionality with the Transform Tool in Adobe Camera Raw.
**Graduated Filter Tool**  
Similar to a graduated neutral density filter, the Graduated Filter Tool can be used to darken or lighten large areas of your shot such as the sky or foreground, by dragging it over the area and then adjusting the Exposure slider. But it does so much more than an ND filter, because you have access to all of the sliders from the Basic panel plus Sharpness, Noise, Moire, Defringe and Color – these will only affect the area you’ve painted over. Hover your cursor over the Adjustment Brush pin and the area you’ve painted will appear in bright red. You can also right-click on the pin to bring up options to Duplicate, Delete and Reset your adjustments. In the example image above we brushed over the iris of the eye and then dragged the Exposure, Shadows and Clarity sliders to the right to give this area more punch. In the Brush Options you can set the Size with the slider, or use the [ and ] keys, as well as the Feather which determines if you have a soft or hard-edged brush, and Flow and Density which help control how much ‘paint’ is applied to your canvas as you brush it. Hit O to see the affected area clearly in a red overlay or remove parts of the selection by clicking Erase and then painting over the offending area.

**Radial Filter Tool**  
This allows you to make a targeted adjustment to your picture in a circular or elliptical area. Draw an ellipse over the portion of the picture you want to affect, drag into place, pull the edges to resize or hover your cursor over an outside edge to see the double-ended arrows to rotate it. With the Invert box unchecked you’ll be adjusting the outside part, so you can add or remove a vignette by increasing the Shadows or Exposure sliders. Tick the Invert box and you’ll be tweaking the inside area – this is great for adding pools of light around your image, or adding a soft keylight. Setting the Feather slider to 0 will give you a noticeably hard edge, so it’s worth dragging it up until your adjustment looks realistic.

**Targeted Adjustment Tool**  
In the Tone Curve panel you have access to the curve graph which allows you to adjust the contrast between your highlights and shadow regions. The handy Targeted Adjustment Tool also lives here, and once active you can click on a specific highlight, shadow, or midtone and then drag up or down to make that part lighter or darker – you’ll see your result appear on the tone curve graph in real time.

**White Balance Tool**  
In the Basic panel you’ll find the Temperature and Tint sliders which change how warm, cool, green or purple your picture is to set the overall white balance. You can also click on the White Balance Tool then select a neutral grey area, such as grey sky or item of clothing, to set an accurate white balance manually. Grey cards can be purchased which are 18% neutral grey, and if you have one of these in your shot you can use this tool to click on it and set the white balance. The card can then be removed from the frame and your correct Temperature and Tint can be synced with the other images from your shoot.

**Red Eye Tool**  
Red eye happens when light from your flash illuminates the back of the eye, though many modern cameras have an anti-red eye feature. But if you do see red eyes (or yellow eyes for pets) you can use this tool to remove them. Click on the eye and use the Pupil Size slider to make sure the whole red area is selected, then tweak Darken until it’s gone.

**NEXT STEP BOOST COLOUR & CONTRAST**  
Take total control of your colour with the HSL panel and get every colour in your shot looking exactly how you want it to. We also show you what the Tone Curve panel does and how you can use it to increase contrast in your RAW images.
Part 4 // Enhancing colour and contrast

Dan Mold explains Lightroom’s Tone Curve and HSL panels so you can make colour and contrast edits to your RAWs more effectively.

Core features explained

The Tone Curve and HSL panels are both found on the right-hand side of the Develop module.

1. Set the default contrast of your Tone Curve

Curves is a fantastic adjustment that many retouchers use in Photoshop to control contrast, brightness and colours, and the good news is you have very similar functionality with the Tone Curve panel in Lightroom, too. But the benefit here is that you’re working on the RAW file and all of its extra data. Click on the Tone Curve panel in the Develop module, then click on the Edit Point Curve icon. You’ll now see that the Point Curve is set to Linear by default. This means the curve is not ‘curved’ – it’s a straight diagonal line from the bottom left of the shadows to the top right of the highlights. You can change this to Medium Contrast or Strong Contrast to set the baseline starting amount.

2. Use the point curve

To take further control of the tones, you can add your own points and move them up or down to bend the curve into a new shape. Before you do this, turn on the Shadow and Highlight clipping warnings, found in the Histogram panel. These show any areas that have burnt out to pure black or white in a garish blue or red (respectively), so you know when you’ve pushed the tones too far. To create a classic ‘S’ curve to increase contrast, click in the middle of the graph, then pull the highlights up and the shadows down (see image above). If you make one point too many, right-click on it and choose Delete Control Point.

3. Make regional adjustments

You can also make regional adjustments to the Tone Curve. Press the Click to stop editing Tone Curve icon and then you’ll see the four Region sliders below. The graph is currently divided into four equal columns for the Highlights, Lights, Darks and Shadows, but you can tweak how broad these boundaries are by pulling the arrowheads underneath the graph to the left or right.

4. Create targeted adjustments

Whether you’re working on a Point or Regional Curve, you can use the Targeted Adjustment Tool, found in the top left corner of the panel – its icon looks like a target. Click this to make it active and then you can click on any tone in the image and drag up to make it lighter or down to make it darker – you’ll see a new point appear on your Tone Curve if you’re working in the Point Curve mode. This is extremely handy if you’re finding it difficult to control a specific tone in your shot using the previous steps. If you want to completely start over you can right-click on the graph and choose Flatten Curve or Reset All to undo your adjustments.
The Tone Curve panel: Adjusting colours and tone

Adjust colours with the Tone Curve

Up until now we’ve been editing the RGB channel of the Tone Curve, which adjusts the Red, Green and Blue in your shot equally, so your adjustments make the shot look lighter or darker. Make sure you’re editing the point curve by clicking the Edit Point Curve icon in the bottom right corner, then you’ll be able to adjust the contrast and amount of Red, Green and Blue in your picture. Just like with the RGB curve, you can create a classic ‘S’ curve to boost the contrast of your colour channels, pull the curve upwards to increase the amount of the selected colour, or pull it down to reduce it. We worked on the Red Channel in the example below, so pulling the curve up made the image more red, while pulling it down made the image more green.

The HSL panel: Take control of individual colours

Hue (Colour)

Go over to the Develop module and click on the HSL panel, which stands for Hue, Saturation and Luminance. Click the Hue subheading and you’ll see the different colour channels appear. Here you can shift specific colours. In our example picture we experimented with the Blue channel. The sky is blue at 0, but becomes more aqua when dragged left and more purple when dragged to the right.

Saturation (Intensity)

Saturation is a term you’ll no doubt be familiar with and by clicking on this subheading you can control the saturation, or intensity, of specific colours. On our example picture once again we used the Blue channel. Dragging it to the left removes colour from the sky, while dragging it to the right will give it a boost. The other colours in the image remain completely unchanged.

Luminance (Brightness)

The last subheading, Luminance, controls how bright or dark the coloured area is. Using the same image and tweaking the Blue channel once more we can see the blue sky becomes lighter when dragged to the right and darker when pulled to the left. For Hue, Saturation and Luminance it’s best to stick to small changes to make a subtle improvement, as your images can look unrealistic when pushed too far.

Above: By default the curve runs from the bottom left to the top right of the graph on every channel, but they can each be tweaked.

The Tone Curve panel: Adjusting colours and tone

Adjust colours with the Tone Curve

Up until now we’ve been editing the RGB channel of the Tone Curve, which adjusts the Red, Green and Blue in your shot equally, so your adjustments make the shot look lighter or darker. Make sure you’re editing the point curve by clicking the Edit Point Curve icon in the bottom right corner, then you’ll be able to adjust the contrast and amount of Red, Green and Blue in your picture. Just like with the RGB curve, you can create a classic ‘S’ curve to boost the contrast of your colour channels, pull the curve upwards to increase the amount of the selected colour, or pull it down to reduce it. We worked on the Red Channel in the example below, so pulling the curve up made the image more red, while pulling it down made the image more green.

The HSL panel: Take control of individual colours

Hue (Colour)

Go over to the Develop module and click on the HSL panel, which stands for Hue, Saturation and Luminance. Click the Hue subheading and you’ll see the different colour channels appear. Here you can shift specific colours. In our example picture we experimented with the Blue channel. The sky is blue at 0, but becomes more aqua when dragged left and more purple when dragged to the right.

Saturation (Intensity)

Saturation is a term you’ll no doubt be familiar with and by clicking on this subheading you can control the saturation, or intensity, of specific colours. On our example picture once again we used the Blue channel. Dragging it to the left removes colour from the sky, while dragging it to the right will give it a boost. The other colours in the image remain completely unchanged.

Luminance (Brightness)

The last subheading, Luminance, controls how bright or dark the coloured area is. Using the same image and tweaking the Blue channel once more we can see the blue sky becomes lighter when dragged to the right and darker when pulled to the left. For Hue, Saturation and Luminance it’s best to stick to small changes to make a subtle improvement, as your images can look unrealistic when pushed too far.

Above: By default the curve runs from the bottom left to the top right of the graph on every channel, but they can each be tweaked.

The Tone Curve panel: Adjusting colours and tone

Adjust colours with the Tone Curve

Up until now we’ve been editing the RGB channel of the Tone Curve, which adjusts the Red, Green and Blue in your shot equally, so your adjustments make the shot look lighter or darker. Make sure you’re editing the point curve by clicking the Edit Point Curve icon in the bottom right corner, then you’ll be able to adjust the contrast and amount of Red, Green and Blue in your picture. Just like with the RGB curve, you can create a classic ‘S’ curve to boost the contrast of your colour channels, pull the curve upwards to increase the amount of the selected colour, or pull it down to reduce it. We worked on the Red Channel in the example below, so pulling the curve up made the image more red, while pulling it down made the image more green.

The HSL panel: Take control of individual colours

Hue (Colour)

Go over to the Develop module and click on the HSL panel, which stands for Hue, Saturation and Luminance. Click the Hue subheading and you’ll see the different colour channels appear. Here you can shift specific colours. In our example picture we experimented with the Blue channel. The sky is blue at 0, but becomes more aqua when dragged left and more purple when dragged to the right.

Saturation (Intensity)

Saturation is a term you’ll no doubt be familiar with and by clicking on this subheading you can control the saturation, or intensity, of specific colours. On our example picture once again we used the Blue channel. Dragging it to the left removes colour from the sky, while dragging it to the right will give it a boost. The other colours in the image remain completely unchanged.

Luminance (Brightness)

The last subheading, Luminance, controls how bright or dark the coloured area is. Using the same image and tweaking the Blue channel once more we can see the blue sky becomes lighter when dragged to the right and darker when pulled to the left. For Hue, Saturation and Luminance it’s best to stick to small changes to make a subtle improvement, as your images can look unrealistic when pushed too far.

Above: By default the curve runs from the bottom left to the top right of the graph on every channel, but they can each be tweaked.
Tips & tricks to edit faster

We're now five parts into our complete Lightroom guide and, if you've been following the series, with any luck you should be able to import and organise your pictures using the Library module, then work them up in Develop and apply advanced adjustments with the Tone Curve and HSL panels.

We know all of this editing can be time-consuming, and no doubt you'd rather be out shooting than sat at a computer. So with that in mind, we've devoted this section of the guide to speeding up your workflow.

You'll master keyboard shortcuts to apply complicated edits faster, have a greater understanding of some of Lightroom's trickier nuances, and uncover the location of some hard-to-find gems and features that you may not have ever realised were built into the program.

We hope you enjoy our top picks...

What is Lightroom Classic CC?

It's Adobe's dedicated RAW editing software used by photographers to organise, label, develop and then export or print images.

1. Rotate your crop
When using the Crop Tool hit the X key to switch from portrait to landscape orientation and vice versa.

2. Turn the lights out
Hit L to cycle through the Light Modes, dimming the Lightroom interface or blacking it out so you can see your image without distracting panels.

3. Collapse panels to make your image larger
The four side panels in Lightroom Classic CC can be expanded or collapsed using the arrow icons. By default they're expanded so you can see the adjustment panels on the left and right, the modules at the top and the Filmstrip at the bottom. Collapsing the panels down lets you view your image much larger on-screen, useful when using the Spot Removal Tool, for example, as you need to see your shot more clearly.

You can quickly hide the side panels by pressing the Tab key, or hold Shift and press Tab to hide them all. Just use the previously mentioned keyboard shortcuts, or click the arrow icons, to restore the panels.

4. Apply different edits to your shot
It's not uncommon to work up the same picture with a range of different styles. To make the process easier you can right-click on your image in the Filmstrip and choose Create Virtual Copy. This will duplicate it in the Filmstrip, but only takes up a nominal amount of hard drive space. With a duplicate shot now in the Filmstrip, you can rework it and apply a different edit to the original, so you can flick between your versions quickly. You can create multiple virtual copies, which is handy if you have a whole different roster of looks that you want to apply to a single shot.

It's most commonly used for working up both colour and mono treatments simultaneously.

5. Colour code and rate
Filters are a great way to organise your shots so you can find the ones you're looking for quickly. You can give your pictures a Color Label or Star Rating by clicking in the Filmstrip and then using the 1-9 keys to star rate, or the 6-9 keys to apply a colour label (you can do both). Alternatively, right-click on the image and choose Set Rating or Set Colour Label. In the Filmstrip click on Filter and choose Rated to see all of the images that you've applied a rating to and then use the star filter next to it to refine which star-rated images you see in the Filmstrip.

6. Remove and reject
If you come back from a shoot with a memory card full of images you're likely to have some pictures that you don't want to edit, because they're out of focus, incorrectly exposed and so on. You can remove images from Lightroom by right-clicking on the picture in the Filmstrip and then choosing Remove Photo – this gives you the option to remove it from Lightroom or delete it completely from your hard drive. Alternatively, you can also Reject images by pressing the X key, then go to Photo>Delete Rejected Photos and then choose Remove or Delete from Disk.

7. Stack images into a group
In a single import you may end up with several images with the same composition, such as a landscape shot at different exposures. To tidy up your Filmstrip it's worth selecting the photos by holding Ctrl and clicking all of the shots you want to group, and then right-click on them and choose Stack>Group into Stack. You'll see them condensed down into a single thumbnail, but you can view all of the images easily by clicking the number that now appears in the thumbnail or right-clicking them and choosing Stack>Unstack.

What you need
- Lightroom Classic CC
- RAW image you've imported into Lightroom Classic CC and want to process

Part 5 // Tips & tricks to edit faster

Tighten your Lightroom skills to shave hours off your edit using Dan Mold's handy hints, super shortcuts and hidden secrets.

It's Adobe's dedicated RAW editing software used by photographers to organise, label, develop and then export or print images.
Find faces quickly

New to Lightroom Classic CC, Face Detection allows you to put names to faces so that you can easily sort through images with those specific people in them. To do it, import your people pictures and head over to the Library module, then click on the People icon above the Filmstrip or press the keyboard shortcut O. Lightroom will then bring up the Unnamed People group and you can type their names in here. These will then appear in the Named People group and you can click on the people here to bring up all of the pictures that Lightroom has detected that person appearing in. Double-click them if you wish to see them larger on screen – you’ll also be able to drag the Face Region around. In the People view you can right-click on the face thumbnails for extra options, including Find Similar Faces, Move to Unnamed People, Remove Face Region and Edit Name.

Use the Grid View

If you’re levelling up your shot or straightening verticals it can be a good idea to switch on Lightroom’s grid overlay. To do this go to View > Loupe Overlay, to see a series of small squares overlaid on your picture. This will then help you make sure the horizon is totally level and any converging verticals are perfectly straight when you’re using the Transform panel.

Work offline with Smart Previews

When you import images you’re linking Lightroom to the physical location of your shots on your hard drive. This means if you work on a laptop and don’t have the external drive you’re working from with you, it’s not possible to edit your shots as they can’t be linked. It’s not always possible to copy the images onto your computer’s hard drive due to space constraints, but one work around is to create Smart Previews. These are much smaller versions of your RAWs that your computer can still access when you reconnect the drive. For the Full Screen and Hide Panels mode, and cycle to the next screen mode with Shift+F set it to normal, F for the Full Screen Preview, Ctrl+Shift+F to undo – Ctrl+Z.

MERGE IMAGES TO HDR AND PANORAMA

A fairly recent and brilliant feature added to Lightroom is the ability to Photo Merge to HDR or Panorama. This merges several pictures into a single DNG RAW file. As you can now edit a single, stitched image, it’s much easier to work up the RAW data across your vista. Before this feature, you’d have to work up the panos in chunks and then bring them into Photoshop to stitch the RAWs together. To do it, highlight the images you want to merge by holding Ctrl and clicking on them in the Filmstrip, then right-click on your selection, choose Photo Merge and then HDR or Panorama to combine them.

Personalise your Lightroom Identity Plate

You can inject your personality into the Lightroom interface by customising the identity plate. Go to Lightroom > Identity Plate Setup and then change the Identity Plate from Lightroom Classic CC to Personalized. Now you can change the colour, font and font size of the identity plate and the module picker buttons. If you have a logo for your photography business you can use this instead, just click ‘Use a graphical identity plate’ and find the logo on your hard drive. When you’re done hit OK to apply and enjoy your new-look Lightroom Classic CC.

Get more from the Histogram panel

It’d be easy to glance over the Histogram panel, but aside from showing you balanced tones in your image are you can turn on the Shadows and Highlights clipping warnings to see any areas that have blown out to pure black or white. It also displays important EXIF data such as aperture and shutter speed values as well as the focal length and ISO used. Clicking the button that says ‘Original Photo’ will allow you to create a Smart Preview.

// GENIUS KEYBOARD SHORTCUTS

Here are some quick and handy shortcuts that’ll help speed up your edits when using Lightroom Classic CC.

For Library Module only

* Grid View – G
* Loupe View – E
* Compare View – C
* Survey View – N
* People View – O

For Develop Module only

* Crop Overlay Tool – R
* Spot Removal Tool – D
* Graduated Filter Tool – M
* Radial Filter Tool – Shift+M
* Adjustment Brush Tool – K
* Change brush size – J
* Auto Settings – Ctrl+U

PRACTICAL PHOTOGRAPHY
Dan Mold shows you how to use RAW power to convert your pictures to black & white for a new look in Lightroom Classic CC.

Black & White has a timeless quality that removes colourful distractions and lets you concentrate on tone, contrast, shape and mood. Mono is also an area that Lightroom Classic CC excels at, as you can take full advantage of the extra data collected and retained by the RAW file format. This is lost when you convert to JPEG and edit in Photoshop. Although we’re converting to mono, with our method the colour data is still there in the background and can be used to great effect to change the brightness of areas in your picture, even when it’s drained of colour. We’ll also show you how to protect your original RAW files with Virtual Copies, creating multiple edits from the same RAW file without substantially increasing the file size.

Here, you’ll also learn how to apply a graphic solarised effect and how to inject a hint of colour to your mono shots with some subtle toning, and all in a matter of minutes. If you’ve already taken your image and weren’t able to shoot in the RAW format, don’t worry – JPEGs can be imported into Lightroom and you can follow the tutorial as per usual, you just won’t have the extra RAW data which will allow you to push the black & white conversion that bit further. Of course, if you prefer to work in Photoshop, you can convert your JPEG to mono using the Black & White Adjustment Layer in Photoshop CC. Find the video lesson at bit.ly/lrvids – all that’s left now is to dig out a suitable RAW file and get stuck in...

Essential panels for mono conversions

The top three panels in the Develop module are indispensable for mono conversions. Basic lets you tweak the exposure, Tone Curve is brilliant for fine-tuning the contrast and B&W provides total control of your tones.

1. Work up the exposure in the Basic panel

When you’ve imported your image into Lightroom Classic CC head over to the Develop module. Before converting the image to black & white we’re going to work up the exposure and contrast in the Basic panel. Start by going to the Filmstrip at the bottom of the interface and then right-clicking on your image thumbnail and choosing Create Virtual Copy – this will give you a copy to work on. You can now apply your mono conversion and have another version to work up in colour later on if you so wish. When you’ve done that, head over to the Basic panel and adjust the sliders until the exposure and contrast look good, using the settings above as a rough guideline.

2. Move on to the Black & White panel

With the contrast and exposure now roughly how you want them, it’s time to head over to the B&W panel. Clicking this will automatically drain any colour from the image. Don’t worry – as we’re working on a RAW file the colour data is still there in the background and we can use the colour channel sliders to change how bright or dark these areas are. Use these for even more control over the contrast in your shot. For this landscape we brightened the Red, Orange and Blue channels, while darkening the Purple and Magenta channels slightly. We didn’t notice much change to the Yellow, Green or Aqua sliders so left those around 0. We’ll fine-tune the contrast even further in Step 4 with the Tone Curve panel, and in Step 5 with some dodging and burning.

3. Go back to Basic panel and refine

Now your image has been converted to mono, it’s a good idea to head back to the Basic panel and refine the sliders. You’ll notice you can now push the Clarity and Contrast sliders much harder because you don’t have to worry about colours breaking up or clipping. Although the White Balance and Tint sliders are usually used to affect colour casts in your picture, they can change the tones of your black & white images drastically so it’s worth experimenting with these sliders too.

4. Use the Tone Curve to adjust light levels

Another way to fine-tune how light your ‘lights’ are and how dark your ‘darks’ are is to use the Tone Curve panel. Click the Edit Point Curve icon and then you can pull directly up or down on the tone curve graph to make those tones lighter or darker. At this point with the image above the highlights and shadows were looking spot-on but the midtones were looking touch too light. We added an anchor point to the highlight and shadow regions to lock them off and then pulled down the midtones so that only these tones were affected. This gave us the resulting contrast we were after.
Dodge and burn with the Adjustment Brush Tool
To take total control of the tones within your image you can use the Adjustment Brush Tool to paint over the specific area in your picture that you want to tweak. Just grab the tool from the Toolbox and set the Highlights to +20 and the Whites to +40 to start ‘dodging’ the light parts of your image. Make sure the other settings are at zero or their default values. Now brush over the areas you want to brighten. When done you can continue to adjust the sliders and, if needed, tweak the Exposure slider too. To ‘burn’ the dark parts of your shot click on New and then set the Highlights to -40 and the Blacks to -10, then brush over the area you want to affect and tweak the Exposure slider if needed. You can hit O to reveal the area you’ve brushed over with a red overlay and, if you paint over an area you didn’t intend to, just click Erase and then brush over it to remove it from the selection. Hit O once again to lose the red overlay.

Recompose with a crop
Grab the Crop Tool from the Toolbox and you’ll see the crop bounding box appear around your picture. If you’re working on a landscape image that has a horizon in it, you can quickly level this by clicking on the Straighten Tool (it looks like a spirit level) and then drawing a line over your horizon. It will then be levelled automatically. Hold Shift as you pull in the corner handles to lock off the aspect ratio as you apply your crop and drag the crop box around the frame until you’re happy with the composition. Hit Return or Done to apply it.

Add style with a vignette & grain
If you’d like to go for a more retro black & white effect, you can use Lightroom to apply a vignette and some grain to mimic the look of old film photographs. Just head over to the Effects panel and then drag the Post-Crop Vignetting Amount slider to the left to darken the corners (pulling it to the right will lighten them). You can also change the Midpoint to control how large the vignette is, the Roundness to make your vignette more squared-off or oval in shape and also the Feather to make its edge hard or soft. When you’re done head down to Grain and drag the Amount slider up a little and then change the Size and Roughness sliders until you get the desired amount of grain.

Achieve abstract solarisation effects with the Tone Curve
If you’ve been following the steps on the opposite page, you’ll want to create a new Virtual Copy just like in Step 1 so that you don’t lose your edit. Working on your new copy click the Reset button to remove the edit. In the Tone Curve panel, select the Click to edit Point Curve icon. You now have a diagonal line going from the bottom left to the top right – drag the control point found at the bottom left and drag it all the way to the top. The line now runs all the way across the top edge. Drag the middle of this line down to create a ‘U’ shape (see above). This will invert your picture and you can change the shape of the U to get the desired effect. Then go to the B&W panel and tweak the sliders to get the mono result you want.

Apply a graphic split-tone effect
When you’re happy with your mono conversion, you may want to inject a hint of colour using the Split Toning panel. Here, you can assign one colour to the highlights and another to the shadows. Above, we set the Highlights to a warm yellow and the Shadows to a cool blue. Then increase the Saturation of each to control how much colour you apply. The Balance slider lets you give a bias towards your highlights or shadows colour.

Two quick mono effects to try

- **Foreground Dodged**
  - Grab the Crop Tool and drag the crop box to the left to darken the corners.
  - Add some grain to get a retro black & white effect.

- **Background Burned**
  - Keep the crop box over the background.
  - Increase the Saturation to add some colour.

**GENIUS**

**SYNC YOUR SETTINGS**

When you’ve nailed down your mono formula, it can save time to apply the same settings to other images. Just hold Ctrl and click on all of the images in the Filmstrip that you’d like to convert to mono, then click on the image with your B&W conversion in it to make it active and hit Sync. Now tick the options you want to copy over and hit Synchronize.
Turn your pictures into an engaging slideshow

1. **The Options panel**
   Import the images you want to appear in your slideshow and then head over to the Slideshow module in Lightroom Classic CC. You can take control using the panels on the right so we’ll start with the Options panel at the top. Click Zoom to Fill Frame if you want to fill the entire presentation window with your picture – it may apply a light crop in order to do so. Use Stroke Border to give your picture a border – you can fine-tune the colour and size of the border here too.

   To give your presentation a professional edge you can turn on Cast Shadow and then adjust the Angle of the shadow around the image and border. You can also tweak how large and opaque the shadow is here.

2. **Layout & backdrop**
   If you’ve given your image a border and drop-shadow, you’ll want to use the sliders within the Layout panel to adjust the size of the surrounding background. You can also set Left, Right, Top and Bottom to 0px to have no surround at all if you prefer. When you’ve decided how much background you want to see you can customise it by heading over to the Backdrop panel to change its colour or add a background image.

3. **Add intro and outro screens with Titles**
   You can bookend the start and end of your presentation using the Titles panel. Make sure you tick Intro Screen and Ending Screen if you want to add these titles and then tick Add Identity Plate. By default your Identity Plate will read your name, so if you want it to say something else, such as “Goodwood Revival 2018”, then click on the identity plate and choose Edit, then type in your text as well as the Font and type Size then hit OK. If you’d like to colour the text make sure you tick Override Color, click the colour swatch and set the one you want to use.

4. **Add music and play your slideshow**
   If you’d like music to play throughout your slideshow then expand the Music panel and click on the plus icon. Navigate to the music track on your hard drive that you’d like to use and hit Choose. It’s nearly time to play your slideshow, but before you do, head over to the Playback panel. Here, you can change how long the slides are shown for and how long the fades last between each slide. It can be worth experimenting with the Sync Slides to Music option and also tick Repeat Slideshow if you want this to happen. Now just click Play to start the slideshow, Space to pause or Esc to exit.
Create your own quality photo book

Putting together a collection of your best images along a similar theme or from a specific trip is one of the most rewarding things you can do. Lightroom Classic CC simplifies the process. First use the Library module to import the pictures that you want to compile into your photo book and when you’ve begun making your book use the Ctrl+Plus or Ctrl+Minus keyboard shortcuts to zoom in and out of the pages.

Here’s how you can put together your own photo book...

1 Set up your book correctly
To get started you need to import all the images that you want to use in your book into Lightroom Classic CC and then head over to the Book module. Let’s start with the Book Settings panel at the top right. Click Book to choose how you want to finish your book from JPEG, PDF or send off to Blurb. Be sure to choose the Size and Cover that you want before adding images, and set the JPEG quality you want when using the JPEG or PDF Book modes.

2 Change the layout of a page
The Page panel is useful for changing the page image and text boxes. Click on the page thumbnail and then scroll through the list of presets to choose one you want to use.

Click Add Page to create a new page with the active preset, or Add Blank to add a totally blank new page. You can also add Page Numbers and choose where these will appear. Cell padding in the Cell panel will increase the distance between the edge of the page and your image.

3 Adjust your text
If your page has a textbox on it, you can click it and you’ll see a yellow line appear around it to show it’s active. You can now head over to the Type panel and use the settings and sliders within. Here you can change the font, adjust whether it’s Bold or Italic text, the colour of the text and also its Size and Opacity. The buttons at the bottom of the panel can be used to align to the left, right or middle and justify the text too.

4 Add extra text
Some of the page templates that you can choose in the Page panel come loaded with text ready to go. If you’d like to add extra text, or you’ve chosen a layout that doesn’t have text where you need it, you can add additional text boxes with the Text panel. Ticking Photo Text and Page Text will bring up two additional text boxes that you can drag, or use the offset sliders to move them up and down the page. Click on a text box to highlight it, showing that it’s active. You can then use the type panel as in the previous step to adjust the font and type size.

5 Change the background
A background image can really help to tie your book together and give it a theme. Expand the Background panel and then tick Apply Background Globally. To set a colour as the background, tick Background Color and then click on the colour swatch next to it and choose the colour you want to use and its intensity. You can also set an image graphic as the background by ticking Graphic, clicking on the graphic thumbnail and then choosing one of the presets or adding your own photo. If you lower the graphic opacity you’ll see it blend in with your chosen background colour.

6 Make use of the Guides panel
If you want your book to feature a lot of text switch on the Text Safe Area guide as this will reveal a faint line in which your text will be safe. Your text will also be constrained to this box. Tick Photo Cells to hide the background on any pages that don’t have an image on them.

7 Export your book when finished
In the Book Settings (top panel) you can change output to JPEG, PDF or Blurb and this will change the ‘Export Book to’ button at the bottom of the panels. Just choose the format you want to use as your end result and then hit this button to begin your export.
Create a professional online picture gallery

One of the wisest things any photographer can remember is that you’ll never make the most out of your images if you keep them locked away out of public view. Instead, share your genius with the world and create an online picture gallery. Usefully, Lightroom Classic CC’s Web module allows you to export your shots straight onto a specific website, or create a gallery that works offline without an Internet connection but runs through a web browser. Here’s what you need to know to get started...

1. Choose the right Layout
When you’ve imported the images you want to use in your web gallery head over to the Web module and then expand the Layout Style panel. There are four different galleries for you to choose from here and then if you head to the Template Browser on the left you can find different presets for each layout. You can also fine-tune it further with the Color Palette and Appearance panels to change the colour and look of the gallery.

2. Add your website and image information
When you’ve arranged the gallery to look as you want it to, it’s time to head over to the Site Info panel. Here you can add a Gallery Title – we used ‘Goodwood Revival 2018’ – and then put your name in the Gallery Author box. If you have a link to your own photography website, you can include this in the Gallery Author URL too. Now go to the Image Info panel and tick Title or Caption if you’d like to add any information to accompany your images. If you find the amount of open panels are becoming overwhelming or distracting, you can right-click on any panel heading and choose Solo Mode – this will ensure that only one panel remains open at any given time, automatically closing all others.

3. Upload or export your gallery
All that’s left is to choose the Quality for saving the images in the Output Settings panel – the lower the number, the smaller your web gallery file size, but more compression will be applied which will cause a reduction in image quality. You can also choose to add a watermark here, and select any sharpening effects you’d like to apply. If you have a website you want to upload the gallery directly to, use the Upload Settings panel and input the server address then click Upload. Otherwise, just hit Export and all of the files, images and information needed to create the web gallery will be saved neatly into a folder in a location of your choosing.

Use the Map module to display your GPS data

When you’ve imported your images into Lightroom Classic CC you can enter the Map module. If your camera has GPS functionality, or if you paired it with a smartphone to record the GPS co-ordinates (see panel below), you can visualise this data here. You’ll find markers appear on the map showing you where the images where taken. Hovering your cursor over the markers will bring up a thumbnail of that image as well as the date and time it was recorded and some basic EXIF information like the shutter speed, aperture, ISO and focal length. This is brilliant if you’re trawling through images on hard drives and can’t place where a picture was taken – the Map module will help you locate it with pin-point precision, giving you the latitude, longitude and altitude. If you’re not already capturing GPS data in your images, see if your camera has this ability and start using it in conjunction with Lightroom.

Although some cameras have a GPS unit built-in, it’s much more common to see cameras that can be paired with a smartphone using Wi-Fi which can then be setup to transfer the GPS co-ordinates to the camera files on your memory card. Turn on GPS on your camera if it has this feature, or if it has Wi-Fi capability, check the manual and app description to see if Geotagging is available.

NEXT STEP ACHIEVE PRINTING PERFECTION

There’s no better feeling than working your pictures up to perfection and then producing a print that looks exactly as it did on screen. We show you how to do it in Lightroom Classic CC’s bespoke Print module.
Achieve printing perfection

Dan Mold shows you how to use Lightroom’s Print module to produce stunning images at home with accurate colours every time.

Here’s no better feeling than seeing your images printed out in all their glory and proudly hanging them on your wall. The great news is that you can achieve good quality home printing with affordable equipment. Lightroom Classic CC has a dedicated Print module that we’ll be delving into to show you how to get set for perfect prints, at the size you want them to be and showing accurate colours.

The Print module

Printing directly out of Lightroom is easy using the Print module. You can access it through the module buttons at the top of the interface or with the quick shortcut Ctrl+Alt+6 on a PC or Cmd+Option+6 on a Mac.

Computer screens are backlit and use red, green and blue pixels to display images, while a printed photo comprises minute dots of ink to create the end result, so not everything you see on screen will be automatically replicated in print. To achieve results as true as possible, we’ll show you how to soft proof your photos in Lightroom – the process of making sure that your printer can accurately recreate what you’re seeing on screen. Here’s all you need to know...

Screen Calibration

Calibrating your screen with a device such as an X-Rite ColorMunki (above) makes it easier to match the image you see on screen with the printed version.

1. Soft proof your shot

Import the image you want to print out in Lightroom Classic CC with File>Import Photos then head to the Develop module. Edit the image to your liking and then hit S, or click Soft Proofing. Now you want to make sure that all of the colours in your image fall within the range of tones achievable with your printer and paper – this is known as the gamut. The Histogram panel will now have changed to a Soft Proofing panel. Here you can change the Profile to a relevant ICC printing profile which will have been loaded if you’ve installed a printer onto your computer. It will give you a list of different paper options too. Right-click on the image thumbnail in the filmstrip at the bottom and choose Create Virtual Copy to make a duplicate. In the next step we’ll be fine-tuning the colours and tones to make them suitable for printing, so this way we’ll be editing the duplicate and keeping the original version unchanged.

2. Tweak the tones to make them printable

Leave the Intent set to Perceptual and then click on the two icons at the top of the histogram. The top left one is the Screen Gamut Warning and shows bright blue over any tones in the shot that your screen can’t accurately display – a correctly calibrated screen really helps here. The one in the top right is for the Destination Gamut Warning and will display bright red where the printer is not capable of printing that tone. If either warnings appear then the tones and colours in your shot will be compressed by Lightroom to make them fall into gamut, so it’s best to take control of these changes yourself before printing. You can do this by adjusting contrast in the Basic panel or the saturation, hue or luminance of your colours in the HSL panel until the warnings disappear.

3. Set up your page and printer

With your colours now displaying accurately you can head over to the Print module. Click on the Page Setup button near the bottom left of the interface and make sure the Format For is set to the printer you’ll be using and the Paper Size is set correctly. Hit OK to apply. Now go to Print Settings and in the panel click on the Show Details button to expand it and set the Quality to Best. It’s worth noting that this panel uses the specific driver of the printer you’ve chosen, so the options will vary from printer to printer. When you’ve configured it as you wish, hit Save to apply the changes.

4. Customise your layout or template

There’s a whole host of printing templates in the Print module, found in the Template Browser panel on the left. You can scroll through these until you find one suitable for your picture. Some templates have boxes for printing multiple images on a page. For this tutorial we chose a single image template to keep it simple. With your template selected, go to the Layout panel to refine the options. Adjust the Margins and Cell Size until the image is the correct size on the paper. It’s worth noting that you won’t be able to set the margins to 0 unless your printer has the capability to print borderless.

WHAT YOU NEED

- Lightroom Classic CC
- Images in Lightroom
- Classic CC that you want to print out

Here’s all you need to know...

The Print module

Printing directly out of Lightroom is easy using the Print module. You can access it through the module buttons at the top of the interface or with the quick shortcut Ctrl+Alt+6 on a PC or Cmd+Option+6 on a Mac.

Computer screens are backlit and use red, green and blue pixels to display images, while a printed photo comprises minute dots of ink to create the end result, so not everything you see on screen will be automatically replicated in print. To achieve results as true as possible, we’ll show you how to soft proof your photos in Lightroom – the process of making sure that your printer can accurately recreate what you’re seeing on screen. Here’s all you need to know...

Screen Calibration

Calibrating your screen with a device such as an X-Rite ColorMunki (above) makes it easier to match the image you see on screen with the printed version.

1. Soft proof your shot

Import the image you want to print out in Lightroom Classic CC with File>Import Photos then head to the Develop module. Edit the image to your liking and then hit S, or click Soft Proofing. Now you want to make sure that all of the colours in your image fall within the range of tones achievable with your printer and paper – this is known as the gamut. The Histogram panel will now have changed to a Soft Proofing panel. Here you can change the Profile to a relevant ICC printing profile which will have been loaded if you’ve installed a printer onto your computer. It will give you a list of different paper options too. Right-click on the image thumbnail in the filmstrip at the bottom and choose Create Virtual Copy to make a duplicate. In the next step we’ll be fine-tuning the colours and tones to make them suitable for printing, so this way we’ll be editing the duplicate and keeping the original version unchanged.

2. Tweak the tones to make them printable

Leave the Intent set to Perceptual and then click on the two icons at the top of the histogram. The top left one is the Screen Gamut Warning and shows bright blue over any tones in the shot that your screen can’t accurately display – a correctly calibrated screen really helps here. The one in the top right is for the Destination Gamut Warning and will display bright red where the printer is not capable of printing that tone. If either warnings appear then the tones and colours in your shot will be compressed by Lightroom to make them fall into gamut, so it’s best to take control of these changes yourself before printing. You can do this by adjusting contrast in the Basic panel or the saturation, hue or luminance of your colours in the HSL panel until the warnings disappear.

3. Set up your page and printer

With your colours now displaying accurately you can head over to the Print module. Click on the Page Setup button near the bottom left of the interface and make sure the Format For is set to the printer you’ll be using and the Paper Size is set correctly. Hit OK to apply. Now go to Print Settings and in the panel click on the Show Details button to expand it and set the Quality to Best. It’s worth noting that this panel uses the specific driver of the printer you’ve chosen, so the options will vary from printer to printer. When you’ve configured it as you wish, hit Save to apply the changes.

4. Customise your layout or template

There’s a whole host of printing templates in the Print module, found in the Template Browser panel on the left. You can scroll through these until you find one suitable for your picture. Some templates have boxes for printing multiple images on a page. For this tutorial we chose a single image template to keep it simple. With your template selected, go to the Layout panel to refine the options. Adjust the Margins and Cell Size until the image is the correct size on the paper. It’s worth noting that you won’t be able to set the margins to 0 unless your printer has the capability to print borderless.
5 Add extra info, a background colour and a watermark

There are some interesting features found within the Page panel such as Page Options which allows you to add Page Numbers, Page Info which tells you the amount of sharpening, printer profile and printer used. Crop Marks will make it easier to cut your print down with a blade to remove the border. If you want to place your image on a background colour make sure the Background Color box is ticked and use the colour box to set a colour of your choosing. It’s worth noting that the background colour won’t be applied to any area that the printer can’t print on – set by the lowest available margin value. You can go back to the Layout panel and tweak your Margins to see the background colour appear. You can also overlay your Lightroom Identity Plate or a Watermark. If you already have a logo graphic activate the Watermarking and click on Edit Watermarks then click Graphic and hit Choose to find your logo image.

6 Use the Guides panel

Switching on the Rulers helps you visualise how large your image, or images, are on the paper. Page Bleed will show a light grey colour on any unprintable areas. Image Cells will put a border around every image window on the print and Dimensions will show you the dimensions and resolution of every image on the paper, which can be helpful when adjusting the Margins within the Layout panel. You can also switch on Margins and Gutters for a visual aid, though it’s worth noting that none on these options in the Guides panel will appear on the final print.

7 Use the Image Settings panel

In the Image Settings panel you can click Zoom to Fill and Lightroom will crop the image so it fills your set print window. You can then drag your image around to fine-tune the composition. Having Rotate to Fit ticked will mean that a landscape image will be rotated to fit a portrait page and vice versa. This panel is also handy if you wish to add a border – using the Stroke Border slider you can change its width and also adjust the colour.

8 Change print resolution and colour management with the Print Job panel

At the top of the Print Job panel you have the Print To option, which allows you to print to a printer or as a JPEG – useful if you want to save the version with a border. Draft Mode Printing is useful for running test prints to use less ink and there’s also a Print Resolution option here which allows you to dial in how fine you want the print to be. Print Sharpening can be switched on or off, and when active you can set the Media Type to Glossy or Matte and also change the sharpening amount to Low, Standard or High. It’s usually best to set the Color Management Profile to Managed by Printer, rather than by Lightroom, using a profile such as Adobe RGB (1998). Just make sure that Color Management is turned on in your Print dialogue box.

9 Try a test print

Although you’ve soft proofed your image it may print differently to the way you expect. So to save on precious ink and photo paper it can be worth loading a set of images onto a contact sheet template – say four images on a sheet of A4 – and print them out. Inspect the colours and tones and tweak them accordingly in Lightroom’s Develop module before making your high resolution print.

Left There’s a plethora of different papers available from matte to glossy and with varying weights too, referred to as GSM. Inks react differently between papers so it’s important to use the unique ICC profile to get the most accurate prints possible.

Lightroom Guide Part 8

Next Step Batch Process and Export

In the final part of our Lightroom masterclass you’ll discover how to save time by batch processing your pictures, and also how to convert your RAW files into more manageable JPEGs for uploading, printing or backing up.

GENIUS GET A CUSTOM PROFILE

Your printer comes with ICC profiles for accurate colours from screen to print. For the ultimate accuracy you can create a custom profile from your own printer using the ICC Profiling Service from PermaJet. If you use PermaJet papers you can print out a test sheet and send it to them to get a custom ICC profile free of charge, or pay a small charge to profile other papers. Visit permajet.com

TIP KEEP THE PANELS TIDY

Right-click on a panel and choose Solo Mode to have one panel open at a time, so it’s simple and easy to see.

TIP KEEP THE PANELS TIDY

Right-click on a panel and choose Solo Mode to have one panel open at a time, so it’s simple and easy to see.
When you’ve edited your RAWs you’ll need to export them to turn them into JPEGs. Dan Mold leads you through the process.

In Lightroom’s export options you’ll be able to apply settings to every single image as they’re saved out. This includes the ability to rename each image and give them sequential numbers – handy for large batches of files such as a wedding shoot – add a watermark to stamp your shots with copyright info, set the size and quality of the pictures, and also apply presets. We cover all of this and more here to complete your journey through Lightroom’s features.

When you’ve edited your RAWs you’ll need to export them to turn them into JPEGs.

**WHAT YOU NEED**
- Lightroom Classic CC
- Images in Lightroom Classic CC that you want to export onto your hard drive

**T’S THE FINAL PART OF our Lightroom Classic CC editing guide, so of course it makes sense that in this module we’ll be looking at exporting your pictures, to turn them from large RAW files to smaller, more manageable JPEGs. Think of exporting as saving your pictures – you’ll be setting up the location on the hard drive you want the images to be stored on, and the file type, but it’s also so much more than that.**

In Lightroom’s export options you’ll be able to apply settings to every single image as they’re saved out. This includes the ability to rename each image and give them sequential numbers – handy for large batches of files such as a wedding shoot – add a watermark to stamp your shots with copyright info, set the size and quality of the pictures, and also apply presets. We cover all of this and more here to complete your journey through Lightroom’s features.

**Export your edited RAW files**

**Part 9 // Export your edited RAW files**

**The Export dialogue box**

Go into Lightroom’s Library module and hit the Export button, or go to File>Export in any module to bring up the Export dialogue box.

**Select images and start the export**

Open Lightroom Classic CC and go to the Library module. In the Filmstrip at the bottom of the interface, hold down Ctrl and click on all the images that you want to export, or hit Ctrl+A to select all the pictures in the filmstrip in one batch. Now click on the Export button, or go to File>Export to bring up the Export dialogue box.

**Name your files**

It’s much easier to use the File Naming feature to give your shots a custom name, than rename them all individually, especially if it’s hundreds of pictures for a wedding or similar. Tick Rename To and then click on the drop-down box and choose the filename layout you like. We chose Custom Name – Sequence, which allowed us to type in the name of our files, Amalfi Coast, and then add a number on the end, with the sequence starting from one. The example text above will give you an indication of how your filenames will appear, and you also have the option to set whether the file extension is lower or uppercase, eg jpg or JPEG.

**Select the file settings for images**

In the File Settings options you can choose the file type that your images will be exported as. You’ll likely be using JPEG most of the time as these are compressed and easy to store, email and upload. You can adjust the amount of compression using the Quality slider – 80-100 is ideal for best quality – and you can also tick the Limit File Size To box to set the maximum kilobytes of that file. You could type in 1000K if you wanted each image to be limited to 1MB or less in size. You can also set the Image format to Photoshop’s native PSD file type or larger TIFF files to retain more image information. You also have the option to save in the universally compatible DNG RAW format, but you can use Lossy Compression here for smaller RAW files.

**Set the export location for the images**

At the top of the Export dialogue you’ll see the Export To drop-down box, which you’ll want to set to Hard Drive, though email and CD/DVD options are available if preferred. Moving down, click on the Export Location tab to expand it, revealing the options within. Under Export To you can choose where you want to save your pictures – select Specific folder and then click Choose to find the location on your hard drive that you want to save the pictures to. Check the box that says Put in Subfolder if you want to create a new folder for the pictures and type in the name for your folder in the adjacent text box. You can also click on Existing Files to choose what Lightroom will do when it encounters files with the same filename – by default it’s set to Ask what to do.

**In addition to saving to your hard drive, you can export to media such as CD, DVD or email.**

**Above** The Export dialogue box has options for file name, image size, watermarking and much more.
5 **Resize images**
This brilliant feature allows you to make all of the images in your export the same size for consistency. To start, tick the Resize to Fit box and then choose from the list that appears. In the example above we chose Long Edge and set it to 2000px with a Resolution of 240ppi, so that all of the pictures would come out at the same length and resolution, regardless of whether they had been cropped in the editing process. There’s also the option here for Length and Resolution, regardless of whether they had been upscaled to reach this number.

6 **Add metadata**
In addition to holding the pixel information that makes up the viewable image on our computer displays, digital photographs hold metadata – information containing the exposure, aperture value, date taken, camera used and so on. When exporting in Lightroom Classic CC you can use the Metadata tab to choose what happens to this info. From the list you can choose Copyright Only, Copyright & Contact Info Only, All Except Camera Raw Info, All Except Camera & Camera Raw Info and lastly All Metadata. You also have the option to Remove Person Info and Remove Location Info if you’d rather not have these in your final shots.

7 **Create a personalised watermark**
The Watermark tab makes it easy to stamp copyright information, or your logo, onto the images as they’re exported. To apply it, check the Watermark tickbox and then click on one of the options from the drop-down menu, or click edit Watermark for more control. Here, you can choose whether it’s text or a graphic that is applied, its size, opacity and where it sits in the frame. Hit Save when you’re happy to create a new watermark preset.

8 **Continue editing**
This option allows you to automatically bring your images into Photoshop when the export has finished. This streamlines the process if you need to transfer your shots into a different program to continue working on them after Lightroom, using the different tools found in Photoshop CC or any other image editing program.

9 **Export quickly using presets**
Lightroom Classic CC comes with four presets built-in – Burn Full-Sized JPEGs, Export to DNG, For Email and For Email (Hard Drive). Presets overwrite any changes you’ve already made in the Export dialogue box, so if you’ve tweaked the settings as you want them, you won’t want to override them with a preset. If you have all of your settings just right, and these are likely to be the same settings that you’ll use in the future, you can turn them into your very own preset by clicking the Add button at the bottom, entering a Preset Name and hitting Create.

10 **Change video formats**
Whether you have video clips among your images in the Filmstrip, or you have solely imported videos into Lightroom, you’ll have the option in Include Video Files in the Video tab. Here you can set the Video Format to DPX, H.264 or Original Format and also set the Quality to Low, Medium, High or Max.

11 **Set the type of sharpening**
In the Sharpening tab you can choose to Sharpen For Matte Paper or Glossy Paper if your intention is to print your pictures, or to Sharpen For Screen. You can also set the Amount of sharpening to Low, Standard or High. If, however, you don’t want to apply any sharpening on export, make sure that Sharpen For is unticked.

---

**TIP!**
You can bring all sorts of file formats into Lightroom Classic CC including RAW files, JPEGs and even videos.
Subscribe today!

Subscribe to *Practical Photography* magazine today and save money with our exclusive reader offers.

“Get *Practical Photography* delivered directly to your door, save money on the cover price and enjoy subscriber rewards.

Every issue features inspiration, advice and reviews, over an hour of exclusive how-to videos, and much more. What’s not to like?”

Ben Hawkins  Group Editor

---

**Free! Exclusive photo skills videos & gifts**

Every issue comes with a free disc/download containing the acclaimed Learn Photography Now show, plus an up-to-date camera buyer’s guide.

---

**New techniques**
Tips and tricks to improve your shooting and editing knowledge.

**Inspirational shots**
Pro and reader images showcased so you’ll never be short of ideas.

**The latest gear**
New cameras and kit put to the test in our expert reviews.

---

Easy online sign up
greatmagazines.co.uk/pp